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: ~“Fhear and | forget | Physics is a powerful new program that acts as © 

I see and I remember your private tutor. It reviews, complements 

I do and I understand and amplifies an introductory course in : 

classical mechanics using the interactive 
abilities of the Macintosh. 

A full year’s course in a single program 

Physics follows a classic curriculum and has been 

designed with and tested by educators. It is compatible 

with major textbooks and provides solid coverage of these 

fundamentals: 

Ancient Proverb 

e Vectors @ Velocity and Acceleration ¢ Newton’s Laws e 

Projectile, Circular, Angular and Simple Harmonic Motion 

e Momentum, Work and Energy Thermodynamics e 

Electric Charge e Electric Current® Magnetisme 

Reflection and Refraction @ Particle Theory of Light e 
~ Wave Theory of Light 

Covers a Full Introductory Course 

ie f 

ced Physics is software for learning es 2 ae "5 
ae | Master an entire year’s material at your own pace, ~ oe 

® oe Using interactive graphics, you can explore and investigate 
* ? 

the basic concepts of physics. Abstract methods and 

formulas come to life on the screen as you learn how to 

manipulate vectors, interpret graphs, and answer problems. 

Experiment with velocity and force to see changes in 

orbital motion. Work with dynamic, kinetic and potential see 

energy simulations to understand their relationships. 2 7 Extensive Animation 

Extensive r review and practice of problems 

Physics has over 300 problems. Learn, review, and ai 

yourself, solving the kinds of problems found in homework 

and exams. Whatever approach you choose to take, help is 

always immediately available-in the form of hints, further 

explanations or answers to problems. Physics has an 

automated Index and Table of Contents for as access to” 

any subject. 

_ Inter active, Immediate Feedback Physics is one in a series of math, science, and liberal arts programs 

from Sensei Software. (Sensei, pronounced sen-say, is the Japanese — ey 3 

word for “master” or “teacher:’) Sensei programs present material in iat. 

intriguing, interactive ways to help students achieve mastery of key 3 

concepts and better their performance in homework and on tests. 

For more information about Sensei and our products, write to us 
at 17 Paul Drive, San Rafael, CA 94903-2101. Published by 
Bréderbund Software, Inc. 3 

© 1986, 1989 Sensei Software | R059 
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Physics 
Manual addendum 
for the 800K 
version 

049 

The following information is for the new 800K | 
version of the program. Please disregard informa- 
tion in the manual regarding 400K disks or creating 
SOOK disks. 

System Requirements: PHYSICS requires a 
Macintosh 512K Enhanced, Macintosh Plus, 

Macintosh SE or Macintosh II. 

Making a Copy: Start by making a copy of your 
program disk. You should always use a copy of 
PHYSICS rather than the original disks. Consult 
your Macintosh manual if you need help. 7 

If you have a hard disk, create a new folder on the 
hard disk. Copy the contents of PHYSICS into the 
new folder. To do this, select all the files and drag 

them over to the Hard Disk. 

The PHYSICS disk is a special master disk. Each 
time you start PHYSICS with your copy, the 
Macintosh will ask you to insert your original disk. 
This enables the Macintosh to read the identifica- 
tion on the original disk. 

This program is copy protected. If you would like a 
backup copy of the program, mail your proof of 
purchase, along with a check or money order for 
$10.00 (Gin U.S. funds), or complete credit card 
information, to the address listed below. 

Special note for owners Es 
512K Macintosh computers 

If you have a 512K Macintosh with a 400K internal 

drive and a 400K external disk drive, request the 
400K version and Broderbund will send you two 
400K disks. Send your disk and your proof of 
purchase to: 

: Broderbund® 
Software Direct® 
P.O. Box 12947 
San Rafael, CA 94913-2947 

© Copyright 1989 Sensei Software, Inc. All rights reserved. 
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DA a eo ee ee ee 

SCHOOL/ORGANIZATION 

ADDRESS 

Cs ee ee ee ee ee 

PHONE NUMBER (daytime). ———C—CSCS—_eveeniing) 

What is the age of the person who will use this program most often? Is the person: 

L] Under 13 years L_] 19-24 L_] 35-44 [_] Male 

L | 13-18 Ses L] 45+ 
Where did you purchase this program? 

Ss Computer Hardware & Software Only Store L_] Book Store 

| Computer Software Only Store [_] Mail or Phone Order 

& Department Store L] Gitt 

L_] Discount Store | LJ Educational dealer 

Was this program purchased for use in your 

home L_] business L] school 

if you checked school: Did you purchase this for your 

L_] classroom & computer lab [_] media center 

How do you find out about software? (check all that apply) 

EE Female 

L_] Educational catalog 

LJ Other 

B Don’t Know 

. zB district 

LJ reviews LI catalogs [_] dealers [] shows [LJ] ads [1 friends [J other 

Do you work on a computer at both your home and place of business? 

LJ Yes L1 No 

What type of computer do you use? 

Home 

LJ Apple Ile/IIc L_] Commodore [| Macintosh Il 

L| Apple IIcs L] 1BM/ compatible L_] Macintosh SE 

LI Atari L_] Macintosh 512/Plus L] Other 

Business 

Saale. item: t—“‘“‘ ‘“‘“‘ LO OO 
[| Apple IIcs LJ 1BM/ compatible [_] Macintosh SE 

L] Atari [_] Macintosh 512/Plus L_] Other 

Which of the following peripherals/accessories do you own/use? (check all that apply) 

Printer: Monitor: 

[_] Dot Matrix L_] Color L| Joystick L_] Hard Disk (20 MB and less) 

L_] Letter Quality L_] Monochrome [1] Mouse L_] Hard Disk (more than 20 MB) 

L] color = Stylus/Graphics Tablet [_] 31/2” Disk 

L_] Laser | L_] Modem (1200 baud and under) 

[_] Modem (2400 and above) 
How much memory does your computer have? 

LJ ask LJ 64k L] 128k LI 256k LI 512k LJ 640k L] 1024K 
Of which of the following magazines have you read at least three of the last six issues? Check box A. 

Which of these do you subscribe to? Check box B. 

A B A B A B 

Bee: [| LJ mfoworld Ee 

[] LJ Classroom Computer Learning [| J instructor Eee 

L_] L.] Compute! LJ] L] MacUser ees 

Bee Computel’s Gazette L_] L) Macworld Lael 

[_} LJ Compute! st L} LJ Nibble ES 
[| LI Electronic Learning ET idee. Magazine ese 

Bee Family Computing L] L] pc Week See 

L] LJ Itncider bo 

Are you planning to purchase a computer in the next 12 months? 

L] ves LJ No 

If yes, what type? 

PC. World 

Personal Computing 

Power Play/Microcomputing 

RUN 

STart 

Teaching and Computers 

The Computing Teacher 

T.H.E. Journal 

L] Apple Ile/IIc L_] Commodore L_] Macintosh II 

L_] Apple Ics [_] IBM/compatible [_] Macintosh SE 
[| Atari L_] Macintosh 512/Plus [_] Other 41255 
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Eric Deeds: Program Design, Project Integration 

Michael Coffey: Shell, Programming Tools 
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Ty Shipman: Additional Programming 
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Tomi Pierce and Steve Patrick: Producers 
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Davis, Randy Buck and Alan Mirviss. 
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PHYSICS 

Introduction 

PHYSICS is a program that acts as your own 

private tutor: it reviews, amplifies, and 

complements an introductory physics course 

using the interactive capabilities of the 

Macintosh. 

PHYSICS is a blend of tutorial material, over 300 

problems, and special interactive animation that 

allows you to experiment with the basic concepts 

of physics. You can learn, review, and experi- 

ment with PHYSICS at your own pace. 

This User's Guide takes you step-by-step through 

every aspect of PHYSICS. Read Using 

Physics for suggestions on how you can start to 

use the program immediately. You will find 

many instructions on how to use specific parts of 

the program within PHYSICS itself; the User's 

Guide is your reference. 

Sensei PHYSICS follows a classic physics 

curriculum, and has been designed with and 

tested by educators. PHYSICS is made to 

complement, supplement, and reinforce textbooks 

using the special capabilities of the computer. 



Using This Guide 

Introduction 

The guide is divided into several sections. 

"Getting Started" explains how to start up the 

program. It also reviews basic Macintosh 

commands you will use throughout the program. 

"Menus" explains how to use the menus. It 

shows how to choose a chapter or a subject in that 

chapter, how to get different kinds of help, 

including references and hints, and how to use the 

various features of the program. 

" Appendix" lists the subject areas of PHYSICS. 



System 

Requirements 

Using the 

Macintosh 

Getting Started 

PHYSICS requires a Macintosh 512K Enhanced, 

Macintosh Plus, Macintosh SE or Macintosh II. If 

you have ordered two 400K disks, either an 

external drive or 800K internal drive is required. 

Though this manual explains some of the features 

of the Macintosh, you should be familiar with its 

basic operation. You should know how to use the 

Finder™ , the mouse, windows, scroll bars, and 

menus. See Macintosh, your owner's guide, for 

instructions. 

This section briefly explains the Macintosh terms 

used in PHYSICS. 

Pointer: A small black arrow is used to "point" or 

"click" things on the screen. Move the pointer by 

sliding the mouse across your desk or tabletop. 

Mouse: The Mouse is an interface device used 

with the Macintosh. In PHYSICS, three common 

mouse activities are: 

Clicking: Position the pointer, then quickly 

press and release the button on the top of your 

mouse, as though hitting a piano key. Clicking 
will select and identify objects on the screen, 

activate buttons, and select menu items. 



Getting Started 

Pressing: Position the pointer, then press and 

hold down the button on your mouse. This is 

the method used to operate the scroll bar. 

Release the mouse button when you are 

finished scrolling. 

Dragging: Position the pointer, then press 

down the button on your mouse. Holding the 

button down, move the mouse to a new 

position. Release the button when you reach 

your destination. 

Menu Bar: The white strip across the top of the 

screen is the Menu Bar. Open a menu by clicking 

a title. Drag down when the item you want is 

highlighted, then release the mouse button. When 

items on the menu are dimmed, they are not 

available. 

«© File Subject Help Options 

Page Turner: To turn forward, click in the tri- 

angle above the page number in the lower right 

corner of the page. (For example, on page 1, 

clicking on the blank triangular page corner will 

turn to page 2.) If you wish to go from page 2 to 

page 1, click right on the page number. Pressing 

steadily will cause the pages to turn rapidly either 

forward or back. 



Making a Copy 

512K Mac 

Getting Started 

Windows: Windows allow you to view different 

parts of the program at the same time, and can be 

moved around the page by dragging on their top 

bar. 

Buttons: Many of the pages in PHYSICS have 

buttons that lead to further information or 

examples. All you need to do is click the button. 

Dialog Boxes: Dialog boxes appear when 

PHYSICS wants to tell you something. 

Start by making a copy of your program disk. 
You should always use a copy of PHYSICS rather 

than the original disk. See Macintosh, your 

owner's guide, for instructions. 

If you have a 512K Mac with a 400K internal 

drive and external disk drive, send your disk and 

the coupon on page 35 to: 

Brg@derbund Software Direct 

P.O. Box 12947 

San Rafael, CA 94913-2947 



Hard Disk 

400K Disks 

Getting Started 

Request the PHYSICS 400K version and Brgder- 

bund will send you two 400K disks. 

If you have a hard disk, create a new folder on the 

hard disk. Copy the contents of PHYSICS into 

the new folder. To do this, select all the files 

except the System Folder and drag them over to 

the hard disk. 

If you have two 400K disk drives, and have 

ordered the 400K format version, copy PHYSICS 

Disk 1 and PHYSICS Disk 2 onto two single 

sided floppy disks. Name each disk "Physics Disk 

1" and "Physics Disk 2" respectively. 



Getting Started 

Starting the = The PHYSICS disk is a special master disk. Each 

Pro gram time you start PHYSICS with your copy, the 

Macintosh will ask you to insert your original 

disk. This is so that the Macintosh can read the 

identification on the original disk. 

w= Insert your copy of PHYSICS into the internal 

drive. Double click the icon called Physics. 

If you have two 400K disks, insert your copy of 

Physics Disk 1 into the internal drive first. Then 

insert your copy of Physics Disk 2 into the exter- 

nal disk drive. Double click the icon called 

Physics. 

# When PHYSICS is loaded, click the Subject 

menu to go to the Table of Contents, to the 

Index, or to the beginning of any chapter. 

@ File Bitigtees Help Options 

Chap. 1 Vectors 

Chap. 2 Velocity and Acceleration 

Chap. 3 Newton's Laws 

Chap. 4 Motion 

Chap. 5 Momentum, Work & Energy 

Chap. 6 Thermodynamics 

Chap. ? Electric Charge 

Chap. 8 Electric Current 

Chap. 9 Magnetism 

Chap. 10 Waves 

Chap. 11 Properties of Light 

Chap. 12 Nature of Light 



Using 

PHYSICS 

Getting Started 

PHYSICS is easy to use and adapt to your 

learning style. 

Make sure you have selected the kind of 

instruction you want from the Options menu. 

Select the Tutorial command if you want to 

review or learn material without doing any 

problems. 

Select the Problems Only command if you only 

want to practice problems. 

Select the All command if you want the full 

program: both tutorial and problem pages. 

If you have not saved your place or you wish to 

Start at a new place, go to the Subject menu. 

Select a chapter if you want to see it from its 

beginning. 

If you want to go to a specific subject, select the 

Table of Contents or Index command. 



Getting Started 

m= If you need background information for a concept 

or are stuck on a problem, go to the Help menu. 

The Reference command is available with all 

options and will take you to the screen that most 

closely relates to the page or problem on which 

you are working. 

The Hint command is available when you are 

working on a problem. It will give you a clue to 

the answer for that problem. 

The Solution command is available when you are 

working on a problem. It will give the answer to 

that problem. However, you must enter the 

solution yourself to go on to the next problem. 

= When you want to stop using PHYSICS, go to the 

File menu. 

Select the Save Place command if you want to 

save your place. A desktop icon called 

Bookmark will appear the next time you insert 

PHYSICS. Double click on it to go directly to 

the place you saved, or double click PHYSICS, 

then use the Restore Place command to take you 

back to your place. 

Select the Quit command to quit the program 

without saving your place. 



Menus 

Apple Menu The Apple menu contains the calculator and 

control panel desk accessories. Check your 

Macintosh manual to see how the control panel 

and calculator work. 

File Menu The File menu allows you to save and restore y 
your place in the program, and to print pages from 

PHYSICS. 

Kd Fite 
Save Place 

Restore Place #f 

Print Page 

Save Place 
Save Place allows you to save your place in the 

program. This is useful if you need to leave the 

program and want to return to the same point in 

your work. When you have saved your place and 

quit the program, PHYSICS will make a desktop 

icon called Bookmark. 



Menus 

Restore Place 
Restore Place restores you to the place you saved 

when you last exited the program. When 

returning to PHYSICS, double click Bookmark to 

go directly to the place you saved, or open 

PHYSICS, then use the Restore Place command 

in the File menu. If you wish to start at an entirely 

new point in PHYSICS, use any of the Subject 

menu commands. 

Print Page 
Select Print Page to print the page currently 

visible on the screen. Any page, including 

problems, can be printed. 

Quit 
Select Quit to quit the program. 

You can use any of the standard Macintosh 

techniques to eject the disk. 



Menus 

Subject Menu The Subject menu allows you to access any part 
of PHYSICS. It lists the Table of Contents, the 

Index and each chapter of PHYSICS. 

© File BRtIaes Help Options 

Table of Contents... 

. | Vectors 

. 2 Velocity and Acceleration 

. 53 Newton's Laws 

. +Motion 

.3 Momentum, Work & Energy 

. 6 Thermodynamics 

. ¢ Electric Charge 

. 8 Electric Current 

. 9 Magnetism 

. 10 Waves 

. 11 Properties of Light 

. 12 Nature of Light 



Menus 

Table of Contents 
When you select Table of Contents, a dialog box 

appears. All twelve chapters in PHYSICS are 

listed in a box on the left. 

Haiz Options 

Chapters 

hermodynamics 

lectric Charge 

lectric Current 

Velocity and Acceleration 

Kinematics 

Displacement 

Speed and Velocity 

Average Velocity 

Constant Velocity 

Instantaneous Velocity 

Displacement from Velocity 

Acceleration 

Average Acceleration 

Constant Acceleration 

Instantaneous Acceleration 

Yelocity from Acceleration 

Uniformly Accelerated Motion 

Equations of UAM 

Click any chapter and a list of subjects covered in 

that chapter will appear in the box on the right. 

To go directly to one of those subjects, click on 

the subject, then click , or simply double 

click your selection. 

Clicking sends the Table of Contents 

away. 

Chapters List 
All twelve chapters contained in PHYSICS are 

also listed in the Subject menu. To go directly to 

the beginning of any chapter, select that chapter. 



Menus 

Index 
= Use Index to search for specific words or terms. 

When you select Index, a dialog box appears. In 

the box is a series of alphabetical "index cards." 

= To search for a word or term, click on the tab 

where the word would be alphabetically listed. To 

find "ampere," for example, click the tab A-Ar. 

* File BiigCiaas Help Options 

Acceleration 

angular 

centripetal 

Area and conductor resistance 

Amplitude of wave & energy 

Angle of incidence 

Angle of reflection 

Angle of refraction 

= Scroll through the listings of words until you get 

to the word or term you want. 

™ Click on the term you want, then click [_ 60 To ), or 

just double click your selection. 

= To return to the Index, click the Subject menu and 

select Index again. 



Menus 

Help Menu | The Help menu offers three categories of 

assistance: Reference, Hint, and Solution. 

€ File subject MM ovtions 
Reference 3& 

Hint 46H 

Solution 46S 

Reference 

Every page of PHYSICS has a Reference page 

associated with it. The Reference page is useful if 

you want background information on the page or 

problem on which you are working. 

= If you select Reference, PHYSICS will show the 

page that most closely relates to the page on 

which you are working. 

@ File Subject Help Options 

Reference - Newton's Laws 



Menus 

# To look at another page in the section from which 

the reference comes, you can page forward or 

backward within the Reference window. 

m While the Reference window is active, you can 

get more information by using Index, Table of 

Contents, or any chapter from the Subject menu. 

Click the close box to return to your original 

page. 

= To get rid of the Reference window, click the 

close box on the upper left corner of the 

Reference page. 

= To see your original page again quickly without 

getting rid of the Reference window, click on the 

page (the edge is visible just behind the 

Reference window). Your page will come 

forward, and the Reference window will go 

behind it. To get back to the Reference window, 

click on its visible portion, and it will come 

forward. 

Hint 
Most problems in PHYSICS have a hint 

associated with them. A hint provides a clue to 

help you solve the problem on which you are 

working. 



Menus 

# To get a hint, pull down the Help menu and select 

Hint. A Hint dialog box will appear. Click 

anywhere on the page and the box will go away. 

Solution 
Solution gives you the answer to the problem you 

are working on in PHYSICS. 

To get the solution, pull down the help menu and 

select Solution. A dialog box containing the 

answer to the problem will appear. Click 

anywhere to make the box go away; enter the 

answer yourself to advance to the next problem. 

Options Menu Every chapter in PHYSICS is a blend of tutorial 
sections, exploration pages, and problem sets. 

You can use these pages separately or together. 

@ File Subject Help Mir — | 

Tutorial 
Problems Only 

“All 

Tutorial 

The tutorial sections cover the subject material 

and animations in each chapter; they do not 

contain problem sets. Select Tutorial, and the 

program will show only tutorial and animation 

pages as you move through the program. 



Menus 

Problems Only 
Select Problems Only when you want to do only 

the problem sets in each chapter. All tutorial 

sections and animation pages will be skipped as 

you move through a chapter. 

All 
When you select All you will be given the com- 

plete package - tutorials, animation pages and 

problem sets - as you move through the chapter. 



Program Content 

Appendix 

The topics covered in each chapter of PHYSICS 

are outlined below. Animations for each chapter 

are listed along with their page numbers. 

Chapter 1: Vectors 

Principal topics covered are: 

Laws of Physics 

Vectors 

Vector addition 

Vector components 

Adding vector components 

Vector subtraction 

Multiplying vectors by a scalar 

Animations for this chapter: 

Page 1 - Chaos 

Page 4 - Vector addition 

Page 6 - Vector addition 
Page 7 - Vector components 

Chapter 2: Velocity and Acceleration 

Principal topics covered are: 

Kinematics 

Displacement 



Appendix 

Speed and velocity 

Average velocity 

Constant velocity 

Instantaneous velocity 

Displacement from velocity 

Acceleration 

Average acceleration 

Constant acceleration 

Instantaneous acceleration 

Velocity from acceleration 

Uniformly accelerated motion 

Equations of VAM 

Animations for this chapter: 

Page 5 - Introduction to velocity 

Page 7 - Average velocity 

Page 9 - Speed, time and displacement 

Page 12 - Instantaneous velocity: calculus 

Page 13 - Instantaneous velocity 

Page 14 - Velocity graph from slope of 

displacement graph 

Page 16 - Displacement: integral of velocity 

Page 17 - Changing velocity / displacement 

Page 19 - Changing velocity / acceleration 

Page 23 - Changing acceleration / velocity 

Page 26 - Displacement, velocity and 

acceleration 



Appendix 

Chapter 3: Newton's Laws 

Principal topics covered are: 

Newton's first law 

Force and acceleration 

Mass and acceleration 

Newton's second law: F=>MA 

Gravitation 

Air resistance 

Terminal velocity 

Newton's third law 

Universal gravitation 

Law of universal gravitation 

Kepler's laws 

Animations for this chapter: 

Page 1 - Inertia 

Page 2 - Force and velocity 

Page 3 - Force and acceleration 

Page 5 - Mass and velocity 

Page 6 - Mass and acceleration 

Page 16 - Falling objects 

Page 25 - Gravitational force 

Page 26 - Motion under gravitational force 

Page 28 - Orbital motion and Kepler's Laws 
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Chapter 4: Motion 

Principal topics covered are: 

Projectile motion 

Frames of reference 

Circular motion 

Centripetal acceleration 

Simple harmonic motion 

SHM and circular motion 

Pendulums 

Angular velocity 

Angular acceleration 

Torque 

Rotational inertia 

Angular momentum 

Animations for this chapter: 

Page 3 - Projectile motion 

Page 6 - Relative motion 

Page 11 - Circular motion: revolution 

Page 12 - Circular motion and centripetal 

acceleration 

Page 16 - Simple harmonic motion (spring) 

Page 17 - SHM: force and velocity 

Page 18 - SHM and circular motion 

Page 19 - SHM: amplitude and period 

Page 23 - Pendulum: SHM 

Page 25 - Pendulum: gravity, force, velocity 
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Chapter 5: Momentum, Work and Energy 

Principal topics covered are: 

Momentum 

Impulse 

Conservation of momentum 

Work 

Kinetic energy 

Power 

Transfer of kinetic energy 

Potential energy 

Potential energy and SHM 

Gravitational potential energy 

Energy in a pendulum 

GPE: stable orbit 

Binding energy 

Mechanical energy 

Animations for this chapter: 

Page 3. - Momentum and impulse 

Page 7 - Center of mass 

Page 8 - Conservation of momentum 

Page 13 - Work 

Page 16 - Kinetic energy 
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Page 22 - Conservation of kinetic energy 

Page 25 - Potential energy 

Page 27 - Potential and kinetic energy in 

SHM 

Page 31 - Potential and kinetic energy in 

SHM (pendulum) 

Page 35 - Conservation of total mechanical 

energy 

Chapter 6: Thermodynamics 

Principal topics covered are: 

Internal energy 

Pressure in gases 

Temperature in gases 

Temperature and pressure 

Energy of gas pressure 

Weather 

Specific heat 

Specific heat: metals 

Thermodynamics 

First law of thermodynamics 

Processes in gases 

Adiabatic processes 

Second law of thermodynamics 

Entropy 
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Animations for this chapter can be found on: 

Page 1 - Internal energy 

Page 2. - Pressure 

Page 4 - Temperature, pressure and volume 

Page 6 - Gravity: molecular motion 

Chapter 7: Electric Charge 

Principal topics covered are: 

Electric charge 

Conductors and insulators 

Conduction and induction 

Point charges 

Coulomb's law 

Elementary charge 

Electric force on particles 

Electric field 

Drawing electric field 

Lines of force 

Electric potential 

Animations for this chapter: 

Page 2. - Electrostatic charge 

Page 10 - Coulomb's law 

Page 21 - Electric potential 
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Chaper 8: Electric Current 

Principal topics covered are: 

Electric current and emf 

Potential difference 

Ohm's law: resistance 

Electric circuits 

Resistors in series 

Resistors in parallel 

Capacitors 

Capacitors in series 

Capacitors in parallel 

Accelerating charged particles 

Oscilloscope 

Animations for this chapter: 

Page 2 - Current in a wire 

Page 7 - Resistance in a circuit 

Page 19 - Change in electric potential 



Appendix 

Chapter 9: Magnetism 

Principal topics covered are: 

Magnetic poles 

Magnetic fields 

Magnetic flux 

Electric current and magnetism 

Magnetic force 

Magnetic force on particles 

Induced emf 

Lenz's law 

Electric generator 

Electric motor 

Magnitude of induced emf 

Animations for this chapter: 

Page 5 - Flux from current 

Page 8 - Magnetic force on a wire 

Page 15 - Induction 

Page 20 - Motors and generators 
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Chapter 10: Waves 

Principal topics covered are: 

Introduction to waves 

Reflection 

Refraction 

Interference 

Standing waves 

Waves in two dimensions 

Interference in two dimensions 

Animations for this chapter: 

Page 1 - Waves (frequency, wavelength and 

amplitude) 

Page 2 - Reflection 

Page 3 - Transmission/refraction 

Page 4 - Interference 

Page5 - Standing waves 

Page 6 - Waves in two dimensions 

Page 7 - Interference in two dimensions 
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Chapter 11: Properties of Light 

Principal topics covered are: 

Reflection 

Spherical mirrors 

Locating images: mirrors 

Object-image relations 

Convex mirrors 

Refraction 

Snell's law 

Critical angle 

Lenses 

Converging lenses 

Locating images: lenses 

Object-image relations 

Lensmaker's formula 

Animations for this chapter: 

Page3 - Reflection 

Page 4 - Parabolic mirrors 

Page 6 - Images in a parabolic mirror 

Page 8 - Distance and height of image in 

parabolic mirror 

Page 10 - Convex mirror 

Page 15 - Refraction 

Page 19 - Critical angle 

Page 21 - Converging lenses 

Page 23 - Images in a lens 

Page 24 - Images and objects: proportion in a 

lens 
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Chapter 12: Nature of Light 

Principal topics covered are: 

Models of light 

Particle model 

Wave model 

Wave and particle models 

Rectilinear propagation 

Intensity of illumination 

Reflection 

Failure of the two models 

Refraction: particle model 

Refraction: wave model 

Diffraction and interference 

Photoelectric effect 

Complementarity 

Synthesis 

Animations for this chapter: 

Page 13 - Refraction revisited 

Page 19 - Quantum Physics 
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